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Purpose

This document covers the process of remote connections to lab equipment in the ME 4390
electronics lab. This document also goes over basic control of the lab equipment such as the
Rohde & Schwarz RTB2002 Oscilloscope and Rigol DG 1022Z Waveform Function Generator.
By the end of this document, students should understand the how to access and control lab
equipment used in their electronics class’ labs.
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Resources Needed
(i) Device with Windows/Mac operating system (desktop or laptop computers highly recommended)

(ii) Reliable internet connection
(iii) Carleton email address and password
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Breakdown of Connection Process

Connecting to and controlling a piece of lab equipment is not as simple as connecting to the
internet and going to a web address. This process consists of 4 major steps. These include
connecting to Carleton’s VPN, using a remote desktop session to log into the jpKnight server,
using a second remote desktop session from the server to log into one of the lab computers,
then finally connecting to the lab equipment via webpage, program, or yet another remote
desktop session. This process can be seen in Figure 1.
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Figure 1: Remote Access Hierarchy

Although this process seems unnecessary, this is crucial to maintaining security and access
control to Carleton’s network. The first step is to use Carleton’s preconfigured VPN to access
the Carleton domain through their firewall. Once in the Carleton domain you can access
the Department of Electronics server, jpKnight, using a remote desktop connection from your
computer to the server. Once you are connected to the server you can access individual lab
computers by using a second remote desktop connection from the jpKnight server to the specific
lab computer. Finally, you can connect to and control the lab equipment connected to that
specific lab computer. Every step is necessary, and cannot be bypassed.
The jpKnight server allows many students to be connected at once, unlike the lab computers
which only allow one student to be connected to each computer at a time. Therefore, it is
suggested that students use the least number of connections necessary when completing a lab.
That is, if a software is web-based and can be accessed online, students should not to connect
to Carleton’s network and should complete the lab on their computer at home. If the software
is installed on the jpKnight server and does not require input from any of the in-lab equipment
such as the oscilloscope or function generator, students should complete their work on the
jpKnight server and not connect to the lab computers. Only if the student requires access to
the lab equipment or software only on the lab computers should they continue connecting to
the lab computers.
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Step 1: Connecting to Carleton’s VPN
In order to ensure the security of the university networks, all students will be required to
use Carleton’s VPN (Virtual Private Network) service for remote login purposes. To set up
Carleton’s preconfigured VPN connection on your computer go to the following link.
https://carleton.ca/its/help-centre/remote-access/
Click on the instructions corresponding to your operating system as shown in Figure 2.

Figure 2: Carleton Remote Access (VPN) Website

You will be taken to a page providing instructions for you to set up your VPN based on your
operating system. Once set up, you must connect to Carleton’s VPN before accessing the
Department of Electronics servers, lab computers, and required equipment.
You will be prompted for your MyCarletonOne (Carleton Central) username and password to log into the VPN. Note that this is different than the login information used to access
the jpKnight server and lab computers. An example of logging into the VPN using Windows
10 can be seen below in Figure 3.
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Figure 3: Cisco AnyConnect on Windows 10 Computer Accessing Carleton VPN

If you have any issues setting up a VPN connection, please contact Information Technology
Services (ITS) for assistance. Their contact information can be found in the link below.
https://carleton.ca/its/contact/
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Step 2: Remote Login into VLSI Server
Once you are connected to Carleton’s VPN you can access the Department of Electronics’
VLSI1 server, jpKnight. All lab computers on the VLSI domain have access to the H: drive,
where you should be saving your files. When working on lab computers, remotely or
not, do not save files to locations other than your H: drive. This includes the Desktop,
Documents, Downloads, and C: drive. These files not only slow down the computer but will
also be periodically deleted.
First, you must login to the VLSI1 server, jpKnight, using a remote desktop connection. To
login to the VLSI server from a Windows computer open the Remote Desktop Connection app.
The shortcut icon for this app can be seen in Figure 4.
If you are using a Mac computer you can download the Microsoft Remote Desktop app from
the App store. Although visually different, you should have no issues following along.

Figure 4: Windows Remote Desktop Connection Shortcut Icon

Opening the Remote Desktop Connection app will open a window like the one in Figure 5.

Figure 5: Windows Remote Desktop Connection Window

In the bottom right, click Show Options to expand the window to show the Computer and
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Username fields.
For Computer, enter ”134.117.38.243”. This is the IP address of the VLSI1 server jpKnight.
For Username, enter VLSI1\{cuLearn Username}. For example, if your cuLearn username
is ‘johndoe’, the Username would be ‘VLSI1\johndoe’. This can be seen in Figure 6 below.

Figure 6: Expanded Remote Desktop Connection Window

Click Connect. You will be prompted for a password. This password is pW{Your Student
Number}. So, if your student number is 123456789, then your password is ‘pW123456789’.
This will open up a window that shows you the VLSI server virtual desktop. Similar to the
desktop on your computer, this is another computer’s desktop (jpKnight) that you are viewing
and can control through the remote desktop window. Figure 7 shows the jpKnight desktop.
Note the top bar; as this is a window, the desktop can be minimized, or resized. If you close the
remote desktop connection window, your remote access session will end, but it will leave you
logged into the computer/server without closing the programs you were using. This can lead
to major issues for any users after you, including not being able to control the lab equipment.
When you are done with the remote desktop session, make sure you log off both
the jpKnight server and lab computer. This will also close your remote desktop session
window. Do this by selecting the Windows button in the bottom left-hand corner and selecting
Log off. This can be seen in Figure 8. Trying to use CTRL + ALT + DELETE will bring up
the options for your local computer, not the remote session.
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Step 3: Remote Login into ME 4390 Lab Computers
To connect to a specific lab computer a second remote desktop connection is needed. Unlike
the first remote desktop connection that originated from your local computer at home, this
remote desktop connection originates from the VLSI1 server jpKnight. Although starting from
a different computer the process is very similar to Step 2. On the jpKnight desktop, locate the
Remote Desktop connection app and open it. This can be seen in Figure 7.

Figure 7: jpKnight Remote Desktop Window

For Computer, enter your assigned computer station. The Username and Password are
the same VLSI login credentials used to access the jpKnight server. This will open up another
window giving you access to view and control the lab computer.
Note that this second remote desktop window is nested, meaning a window within a window.
Although they are nested it is typical for the lab computer remote desktop window to completely fill the jpKnight remote desktop window, making it appear that the jpKnight window
has disappeared. This is further accented by the remote desktop window bars overlapping
each other. Nonetheless, the lab computer remote desktop window can be minimized and
resized. If you are ever confused as to which virtual desktop you are looking at, compare the
desktop background image. The jpKnight background is significantly darker, shown in Figure
7, compared to the lab computer background shown in Figure 8.
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Figure 8: Lab Computer Remote Desktop Window

Remember to properly log off of both the jpKnight server and lab computer when
you are done. Failure to do so can lead to major issues for any users after you, including not
being able to control the lab equipment.
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Step 4: Accessing And Controlling Lab Equipment
Many electronics labs require the use of an oscilloscope and function generator for measurements and input. It will be important to familiarize yourself with the process of accessing and
controlling them efficiently and in a timely fashion to succeed in each lab. The equipment that
can be remotely accessed can be seen in Figure 9.

Figure 9: Rohde & Schwarz RTB2002 And Rigol DG 1022Z To Be Remotely Controlled
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Rohde & Schwarz RTB2002 Oscilloscope
Before diving in to how to connect to the Rohde & Schwarz RTB2002 oscilloscope, it is important to understand what an oscilloscope is. An oscilloscope is a measurement device that
allows measurement and visualization of AC signals. These devices are very powerful and
commonly used throughout your electronics courses.
To connect to the oscilloscope, open Firefox on the lab computer. The shortcut icon can be
found on the lab computer’s virtual desktop, as seen in Figure 8. Note that Google Chrome
will not work for accessing the oscilloscope. Enter the associated oscilloscope alias for
your station into the address bar. The alias will follow the pattern of ‘Scope##.vlsi1’. You
should be taken to the home page of the Rohde & Schwarz Oscilloscope as shown in Figure 10.

Figure 10: Rohde & Schwarz RTB2002 Remote Access Home Page

On the left-hand side, click the ‘Remote Front Panel’ link as circled in red in Figure 10.
You will be taken to a virtual interface in your web browser that allows you to control the
oscilloscope. It will look like the screenshot shown in Figure 11.
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Figure 11: Oscilloscope Remote Control Front Panel

From this page you will be able to control the buttons and knobs and see the waveform output
as if you were sitting in front of the physical oscilloscope. For more information on how to use
the oscilloscope, see Appendix A.
Lastly, make sure you close your browser window when you are done to allow other
classmates a chance to access the scope. Only one user can control a scope at a time. To extend
this issue, if you do not close your browser and do not properly log out of the lab computer,
future users will not be able to access the oscilloscope long after you are done. Currently the
only way to fix this issue is to have the original user log back in to close the browser, or to
have the computer restart which cannot be initiated remotely.

Rigol DG 1022Z Waveform Function Generator
The Rigol DG1022Z Waveform Function Generator (or function generator) can be used to
create many different AC signals such as sine waves and square waves. These are typically
used as input for circuits. Remote control of the Rigol DG1022Z can be done using the
DG1022Z UI executable on the desktop. A picture of the app icon can be seen in Figure 12.

Figure 12: Rigol Waveform Generator Executable

Opening the executable will open a window as seen in Figure 13.
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Figure 13: Rigol Function Generator User Interface Window

This user interface allows you to control the type of output signal provided (Sine, Square,
Ramp, and Noise), the peak-to-peak voltage of the signal (Voltage VPP ), the frequency of the
signal, and whether or not the signal is enabled or turned off. To change the type of signal
provided simply select the desired signal from the Function options. To change the voltage
or frequency simply type in the desired value and hit enter. Lastly, to enable the output, click
the Enable Output button. When highlighted blue, the output is enabled for the respective
channel.

USB Camera
Although the equipment is being controlled remotely, the measurements being taken are not
simulations. These are real circuits connected in the lab by lab technicians. To view these
circuits in real-time, a USB camera has been set up at each station. To view this video feed,
open the Camera app located on the desktop. Figure 14 shows the app icon.
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Figure 14: Camera App Icon

Once the app is open, a window will appear showing the video feed. No other input is necessary.
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Appendix A: Oscilloscope Operating Instructions
The oscilloscope is one of the most useful and powerful tools at your disposal in the lab. Even
with it’s common use, many students do not fully understand the proper use of an oscilloscope.
This guide will not go over many of the useful functions the oscilloscope can provide, but will
instead cover basic control to get students working with the oscilloscope.

General Layout
To begin, we’ll look at the layout of the oscilloscope. Figure 15 shows the front face of the
oscilloscope in its most basic form.

Figure 15: Oscilloscope Remote Control Front Panel

On the left is the oscilloscope screen. This screen shows the oscilloscope measurements along
with a visual representation of the measured waveforms. Above the waveform display area
on the left are a number of useful modules, and on the right is the acquisition settings. For
the most part these acquisition settings will remain untouched, but the modules on the left
will likely be used. The useful modules include the Meter module, which acts as a digital
multimeter, and the Annotation module, which allows you to add text to the screen. This is
useful to add your name and student number when taking screenshots. If you would like to
add or remove modules to this area, simply select the gear in the middle of the top section of
the screen.
Below the waveform display area is where measurements and the scale factor for each waveform
are displayed. To the right of the waveform display area is where menus are shown. To enter
or exit the menus, simply click the blue R&S logo in the bottom right-hand corner.
On the right-hand side of the oscilloscope is an assortment of buttons and knobs for controlling
various settings and functions of the oscilloscope. In the light blue section are the controls for
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positioning and scaling waveforms in the waveform display area. The dark blue section contains
controls for Triggering, Action, and Analysis.

Viewing And Resizing Input Channels
To turn on or off one of the input channels on the oscilloscope, select the appropriate channel
button, Ch1 or Ch2, in the Vertical area. When turned on, the button will light up the colour
of the waveform, yellow or green for Channel 1 and 2 respectfully. One press is needed to turn
on each channel, whereas 2 are needed to turn off a channel. Alternatively, the channel can be
turned off in the menu that appears.
To adjust the the vertical and horizontal positioning and scales of each waveform use the horizontal and vertical positioning and scale knobs respectfully. You will note that the horizontal
knobs adjust all waveforms on the screen whereas the vertical knobs only adjust the selected
waveform. To change the selected waveform, simply press the desired channel button. You
will notice the rings surrounding the vertical knobs change colour to match the channel being
controlled.
It is ideal to have 2 – 3 periods of a waveform visible by adjusting the horizontal settings, while
adjusting the vertical settings so that the waveform fills as much of the screen without being
cut off. This will allow for the most accurate measurements using an oscilloscope.
Looking at Figure 15 again you will notice a small tag on the left-hand side of the waveform
display area with the text C1 inside. This tag points towards the location of channel 1’s waveform. If you cannot see a waveform because the horizontal settings have moved it off-screen,
you can use this tag to find where it has gone. A quick fix to this is to click the center of the
vertical positioning knob. This will bring your waveform back to the center of the screen. Alternatively, pushing the center of the scaling knob changes the scaling from course adjustment
to fine adjustment. This also goes for the horizontal setting knobs.

Trigger Settings
Although the trigger settings can be a bit more confusing, they are crucial to properly use an
oscilloscope. The trigger tells the oscilloscope where your waveform starts. This in turn gives
the oscilloscope a reference in which to compare the waveform to time 0 and allows repeating
waveforms to be ‘locked’ into place based on this beginning value. You will notice a small
crosshair at 0 seconds in line with the trigger level. Without this, your waveform can jump
around as it is sampled, causing measurements to be incorrect.
To properly trigger your waveforms, you will first need to determine which waveform is better
defined. A waveform with excess noise can cause the triggering to be non-uniform, leading to
issues. Once determined, you can change the source of the triggering by pressing the Source
button in the Trigger area to change the colour until it matches the desired channel. Next,
adjust the trigger level so that it lines up with a non-horizontal point on the waveform using
the trigger level knob. The default setting is for the oscilloscope to look for a rising edge at
this voltage level to be the beginning of the waveform. Like the position knobs, pressing the
center of the trigger level knob places the trigger level at the center of the waveform. This is
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typically a safe location for triggering to take place. Pressing the Trigger button opens the
trigger menu which offers more flexibility to set up the trigger, but these are typically not
needed to be adjusted. Once properly triggered, the ‘Trig’d’ light will light up green on the
oscilloscope and the waveform will be stable.

Cursors
Cursors are one of ways in which you can make measurements on an oscilloscope. Unlike other
methods, cursors are a manual measurement, giving way to quick and accurate measurements
that are very flexible. To enable the cursors, press the Cursor button in the Analysis area.
Pressing this button again with open up the cursor menu. Within this menu you can turn the
cursors on or off using the toggle switch at the top. You can also change the type of cursors.
Vertical cursors are often used for measuring time, Horizontal cursors are used to measure
voltages, Vertical & Horizontal places both vertical and horizontal cursors at the same time,
and V-Marker measures the voltage of the wave at a specific time.
The next thing this menu offers is to select the source you are measuring. As you discovered
each channel can have different vertical scaling options. Because of this, it is important to
select the correct source you are measuring, or your measurements will be wrong. Next is Track
Scaling and Coupling. Track Scaling allows the cursors to scale with any scaling changes. This
effectively ‘locks’ the cursors to the waveforms, whereas without this the cursors would stay
in the same spot on the screen as scaling occurs. Coupling locks the cursors together, making
both cursors move when one is moved. This preserves the distance between the cursors. Lastly
is ‘Set To Trace’ and ‘Set To Screen’. ‘Set To Screen’ resets the cursors to a default location;
useful if you lose the cursors somewhere off screen. ‘Set To Trace’ on the other hand moves
the cursors to ‘important’ locations on the waveform. Note that these ‘important’ locations
are determined by software and can lead to unintended results. Because of this, you should
become proficient in making measurements without this function.
Once the cursors are turned on you can find their measurement readings below the waveform
display area. These readings not only show the values of each individual cursor, but the
difference between them, denoted with the ∆. To move the cursors, you can simply click and
drag them, or by using the Analysis knob next to the ‘Cursor’ button. This knob is used
for various functions and uses, but when the cursors menu is open the knob will control the
cursors. Rotating this knob moves the cursors as you would expect but clicking the center of
the knob cycles through the cursors. The currently highlighted cursor will change to a solid
line, and the cursor number at the end will change to orange.

Measure
Another way to make measurements on the oscilloscope is to use the predefined measure
functions. These measurement values appear below the waveform display area similar to the
cursors. To access these, press the Meas button in the Analysis area. This will open the
Measure menu. This menu allows selection of the measurement place, a toggle to turn on
or off the measurement, measurement type, the source, and a toggle to show measurement
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statistics.
The measurement place is simply a selection of which measurement slot the measurement will
take place. This therefore directly reflects the number of different measurements that can be
done at once. The measurement type is all the different predefined measurement functions the
oscilloscope offers. These include frequency measurements, peak-to-peak measurements, and
RMS value measurements. The source allows you to select which channel is being measured.
Some measurement functions require 2 channels, such as the delay measurement function. And
lastly, the statistics toggle allows you to see the statistics being collected by the oscilloscope
for more complete measurements. These include not only the current value, which is the
one displayed when statistics are not showing, the mean value, maximum and minimum, the
standard deviation, and the wave count used to determine the data.

Math
The Math function of the oscilloscope is a powerful way of performing measurements and
displaying waveform parameters that cannot be immediately measured. One of the more
common uses found in labs is the ability to generate the difference between AC signals. This is
important because you cannot use a single oscilloscope probe to measure across a component
not already tied to ground. If you tried doing this, you would short one of the nodes to ground
via the internal ground of the oscilloscope. You also cannot simply measure one node, then
the other, and subtract the difference as you would in DC as there might be a phase difference
introduced.
To properly set up a measurement across a device such as this, two oscilloscope channels are
used. One connected to one node, and the other connected to the second node, with the
oscilloscope grounds connected to the ground of the circuit. Then using the Math function of
the oscilloscope a third waveform can be generated and displayed for measurements.
To set up this third Math waveform, press the MATH button in the Vertical area. As this is
technically a waveform, pressing the button once displays the waveform, whereas twice opens
up the menu. Unlike other menus, a larger menu appears that takes up much of the screen.
From here, up to 5 Math waveforms can be set by choosing the sources, operation, and units.
Similarly to Channels 1 and 2, these Math waveforms can be scaled, moved, and measured.
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ELEC 3509
Introduction To Multisim 14.2

Carleton University

Department of Electronics

A

Purpose

In this document, you will create and simulate an RLC circuit and response to a voltage step
source with different resistor values. For this, we will perform a nested transient simulation
under a parameter sweep.
By the end of this document students will have Carleton’s VPN set up and understand how
to connect to the VLSI server, jpKnight. They will also understand the how to create circuits
and simulations to gain meaningful information using Multisim 14.2.

B

Resources Needed

(i) Device with Windows/Mac operating system (desktop or laptop computers highly recommended)
(ii) Reliable internet connection
(iii) Carleton email address and password

C

Accessing Multisim 14.2

To begin, connect to the VLSI server, jpKnight. For instructions on how to access the jpKnight
server, please review the Lab Remote Connection Reference Document.
Multisim 14.2 can be found on the desktop of the jpKnight server. Figure 16 shows the program
icon.

Figure 16: Multisim 14.2 App Icon
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Part 1: Building an RLC Circuit
Once the application has opened, you will be greeted with a blank workspace, similar to the
one shown in Figure 17. The workspace is the large pane on the right-hand side. In this
workspace you can add components to build your desired circuit and add measurement probes
for testing and simulation.

Figure 17: Blank Multisim Workspace

The RLC circuit we will be building can be found in Figure 18.

Figure 18: RLC Circuit With Voltage Probe And Step Voltage Source
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Multisim 14.2 has a large library of available components to use to create professional quality
designs. To add components, select Place → Component. A window will appear as shown
in Figure 19. Components are sorted into Groups and subsequent Families. The groups and
families can be changed along the left side of the window.

Figure 19: Multisim Component Library

Generally speaking, most of the components that will be used for lab purposes can be found
in a small set of groups and families. These Groups include the Sources, Basic, Diodes, and
Transistors groups, with appropriate families in each. Although similar components can be
found in other groups and families, many of them are specific real-world parts, requiring
individual part numbers for each lab component.
For the circuit in Figure 18, the required components are {Group: Family: Component}:
• Sources: POWER SOURCES: GROUND
• Sources: SIGNAL VOLTAGE SOURCES: STEP VOLTAGE
• Basic: RESISTOR: 100
• Basic: INDUCTOR: 10m
• Basic: CAPACITOR: 1u
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Once on the workspace, components can be dragged to new locations, rotated using Ctrl +
R, and double-clicked to edit their values and names. Adjust the Step Voltage to have a step
time of 0 ms. Also adjust the label to ’V Step’ by changing the text in the RefDes field under
the Label tab.
To connect wires, hover over the end of the desired component pin. Your mouse will change
to a black dot with crosshairs. Click on the pin, then click on the desired location pin or wire
to complete the connection.
Once the circuit is built to match Figure 18 add a voltage probe to the node between the
inductor and capacitor to measure V OUT. Probes can be placed by selecting Place → Probe
and selecting the appropriate one. Double click on the probe and change the RefDes to V OUT.
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Part 2: Simulating Circuits
Nested simulations can be very common in integrated circuit simulators, these nested simulations allow us to gain a lot of data with little effort. Doing a parameter sweep like this can
show us how the circuit responds to a wide array of values for the set variable, which in turn
can save us time and help us understand what might be going awry in any given instance. In
this case, the variable will be the resistance.
The nested aspect of the parameter sweep allows us to perform regular simulations under the
different values of the parameters.
First we must open the Analysis and Simulation window. You can access this window by
going to Simulation → Analysis and Simulation or by clicking on the text to the right of
the green play button.
This will bring up a menu with many different Active Analysis options. You will want to
choose Parameter Sweep from the list on the left-hand side, along a number of options to best
sweep the resistor value in the RLC circuit.

Figure 20: Parameter Sweep Simulation Options

Above is the Parameter Sweep simulation menu with a number of options filled in. Let’s go
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through each option to express what we’re trying to accomplish for the sweep.
Within the Sweep Parameters box, Device Parameter has been chosen for the Sweep Parameter,
the chosen Device Type is Resistor, and the Name is R; corresponding to the desired component
RefDes. The Parameter field is the parameter to be swept for the component. This is selected
to be the resistance value of the resistor.
In the Points to Sweep box, the selected the range of resistances you will want to sweep over
can be set. So as expressed in Figure 20, the Sweep Variation Type is Decade, which means
that the points of values will be spread over a decade logarithmic scale. Although this variation
type is only one of the options, it is important to understand which Sweep Variation Type you
will use to best express your data. The Start value is set to 10 Ω, and the Stop value is set
to 1 kΩ. The number of points per decade is set to 3, which means that when this simulation
is run, we will end up with 6 sweeps, as there is a 2 decade difference between the Start and
Stop values.
In the More Options box, we will set the the Analysis to Sweep to Transient, making a Transient
sweep the sub simulation under the parameter sweep. This means for each resistor value, a
transient sweep of the RLC circuit with the voltage step input will take place.
Figure 21 shows the Transient sweep, simulation options window. This window is found by
selecting the Edit Analysis... button in the More Options box. The settings in this window
defines the limits of the nested sweep, and it’s important that these settings are given with
parameters which best show the step response of the RLC circuit.
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Figure 21: Nested Transient Sweep

In Figure 21 you are able to see the Start and End time for the Transient sweep. The End time
was chosen as an appropriate range for the RLC circuit as to show a number of oscillations.
The start time was chosen as it starts when the step voltage signal starts. This is not always
the most appropriate start time for the simulation, as we may want to see how the circuit acts
before any changing conditions, but is acceptable here.
The Initial Conditions are set to Determine Automatically, which works especially well for our
RLC circuit, but it should be good to explore the options to see which one works best for your
circuit. We can set default initial parameters for the circuit, which will allow us to leave less
setup time for our circuit.
Maximum Time Step and Initial Time Step allow us to define the amount of time between
data points in the Transient sweep, and so a lower time step will result in a denser point plot.
This can be especially good if you are looking to gain highly defined measurements of your
circuit, although you may leave these to be determined automatically if you decide the point
density does not change the results significantly. It should be noted that a higher point density
also means a much longer simulation time, especially as the transient sweep will need to be
performed many times.
Try changing the time step to see when the characteristics of the step response become too
challenging to read. You should also attempt to decrease the time steps to see how the point
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density defines how long it will take for a simulation to complete.
Lastly, the output tab allows you to chose which parameters are going to be tracked, although
if the RLC circuit has the V OUT probe as seen in the circuit diagram, then the output should
already appear as the output option.

Part 3: Saving Data and Designs
It is always suggested that you save your work often. This helps prevent large loss in the event
of something going wrong with the system such as a power failure. As such, saving every 15
minutes is the recommended interval.
To properly save your Multisim project, select File → Save. It is important to remember to
save all files to the H: Drive, and not anywhere else such as Documents, Desktop, or the C:
Drive. Files in these locations are not transferable within the VLSI network, slow down the
computers, and will be deleted periodically.

Finally, you may find it useful to export simulation data to be used in another program such
as Excel or Matlab. After simulating, a Grapher View window will appear with the simulation
results. In the Grapher View window, go to Tools → Export to Excel. Select all traces to be
exported, and select OK. A new Excel spreadsheet will automatically be generated and open.
Save this file to your H: Drive for later use. This file can also be imported into Matlab.
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Part 4: Common Emitter Amplifier
Let’s now try simulating an amplifying circuit. This will mostly be left to the reader to design.
We are going to make a Bode plot of a common emitter amplifier, and see how the common
emitter amplifier reacts to different inputs and values.
You can find this common emitter amplifier on page 470 of Sedra/Smith’s Microelectronic
Circuits (7th edition). We are constructing this circuit to see how it operates given different
frequency inputs. If you would like to practice your calculations of the small signal circuit,
please refer to the exercise on page 471.
We want to only analyse the AC component of the signal. Isolating this from the DC component
can be done with a high pass filter on the input and output nodes. This can be seen in Figure
22

Figure 22: Common Emitter Amplifier Circuit

The V sig component comes from the Source group, and is an AC VOLTAGE source. V cc is
15 volts, and they are both V REF3 from Source: POWER SOURCES.
Q1 is a NPN BJT from the Transistor group, and it is a 2N3904. The capacitors are all 100
µF, with R b1 = 182 kΩ, R b2 = 100 kΩ, R sig = 10 kΩ, R L = 20 kΩ, R c = 18 kΩ, and R e
= 8.6 kΩ.
After all the components are added and the wires are connected, you must add a voltage probe
to the output for the Bode plot measurements. In the Analysis and Simulation menu, you can
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pick AC Sweep from the list of options. If you want to see the bandpass-like output sweep from
this amplifier, I would suggest you sweep from a decade frequency very close to zero upwards
to 10 Mega-Hertz, with 10 points per decade. Your simulation settings window should look
similar to Figure 23.

Figure 23: Common Emitter AC Sweep

We should use a Decibel vertical scale to stay consistent with the rest of the course. The
output tab should hold the output V out. Finally, save and run the simulation settings to get
a Bode plot complete with the phase and magnitude of the output.
Amplifiers have a very sensitive input range. Small signal analysis, by name, means that the
input signal must be small in order for the output signal to not be clipped. It is necessary
to know the desired range of the output signal when designing your circuit. The Common
Emitter amplifier designed on page 471 is supposed to have a voltage swing around 4 volts, so
we should see that when we connect a signal source to the signal input, and amplify the circuit
appropriately.
For this part, we’re going to perform an interactive simulation, where we use components
commonly used in the lab; specifically the waveform generator and oscilloscope. You can find
the waveform generator and oscilloscope on the right side of the workspace window. There are
a number of tools available, including signal analysers, frequency counters, and multimeters.
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You can see the two tools being used for this Common Emitter circuit in Figures 24a and 24b.

(a) Oscilloscope

(b) Waveform Function Generator

Figure 24: Analysis Tools

Replace the input voltage signal of the circuit, V sig, with the waveform generator, and the
output voltage probe, V out, with one channel of the oscilloscope. Also probe the input voltage
with a different channel of the same oscilloscope. The circuit reference is to ground, and so
the oscilloscope and function generator can both be referenced to ground.
This will result with a circuit that looks similar to that of Figure 25. The only things that
have changed so far are the input voltage source, and the probes.
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Figure 25: Common Emitter for Interactive Simulation

Now change the colour of the A channel wire as to change the signal colour on the oscilloscope.
The steps for changing the colour of the wire is shown in Figures 26a - 26c.
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(a) Select Properties for Net Wire Options

(b) Choose to change the net colour from the Net
Properties Window

(c) Select the appropriate colour

Figure 26: Changing Wire Colours

Now we must also select an appropriate frequency and amplitude for our input waveform
generator. In the Function Generator Properties, shown in Figure 27, the frequency is 1 Hz.
You should note from the Bode plot that at 1 Hz the signal has a low gain, and so you should
make sure to change the frequency to a point with a maximum gain. You should start out with
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an amplitude of 1 mVp so that when you start the interactive simulation, the output signal is
not clipping.

Figure 27: Function Generator Properties

Once the waveform generator is set up, you should start the interactive simulation by
selecting Simulate → Run, or by using the green play button. Double click on the oscilloscope
to see the real time view. You should scale the Timebase along with either Channels so to
best resolve the signals. You can use the cursors at the top of the oscilloscope display to scan
along the two signals, and take measurements as per the selected time. You can also pause
the interactive simulation at any time to take measurements without having to deal with the
changing signal.
You can see the oscilloscope display in Figure 28. Note down the selected parameters. You
can change the Y position of either channel as to disjoin the two signals.
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Figure 28: Oscilloscope Display

As an exercise to the reader:
• Perform the exercise on page 471 of Sedra/Smith’s Microelectronic Circuits.
• Change the amplitude and frequency, see how the signal clips at different frequencies.
• At what point does the output begin to clip? Why is this?
• What kinds of changes would you make to increase the voltage swing of the output?
(Don’t worry if you can’t do this yet.)
• What might you do to measure the input and output impedance’s of the common emitter
amplifier? Try simulating this.
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